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ET-BASE AVR EASY88 
 

 
 

 ET-BASE AVR EASY88 เปนบอรดไมโครคอนโทรเลอรในตระกูล AVR โดยบอรดเลือกใช

ไมโครคอนโทรเลอร ตระกูล AVR เบอร ATMEGA88 ของ ATMEL เปน MCU ประจําบอรด โดย MCU รุนนี้

จะบรรจุอยูภายในตัวถังแบบ 28 Pin DIP โดย MCU ตัวนี้จะมีจุดเดน คือ เปนไมโครคอนโทรลเลอรขนาด

เล็กแตเพียบพรอมไปดวยทรัพยากรพื้นฐานตางๆอยางครบถวน เหมาะแกการใชในดารศึกษาเรียนรูสําหรับ

ผูเริ่มตน และยังสามารถนําไปประยุกตใชงานตางๆไดโดยงาย ซึ่ง MCU สามารถทํางานไดดวยความถี่

สูงสุด 20MHz ที่ 1 Clock / Machine Cycle นอกจากนี้แลวยังมีความเพียบพรอมดวยอุปกรณพื้นฐาน

ตางๆที่จําเปนตอการใชงาน ไมวาจะเปนหนวยความจําสําหรับเก็บขอมูลแบบ EEPROM ขนาด 512 Byte 

และหนวยความจําใชงานแบบ SRAM อีก 1 K Byte สวนในดานของอุปกรณ Peripheral นั้นก็นับวา

ครบถวนเหมาะแกการนําไปประยุกตใชงานเกี่ยวกับการควบคุมและประมวลผลตางๆไดเปนอยางดี โดยจะ

มีทั้งระบบฮารดแวรของ SPI, UART, I2C, Watchdog, Timer/Counter, PWM และ ADC ฯลฯ 

โดยการออกแบบโครงสรางของบอรดนั้น จะเนนเรื่องขนาดของบอรดใหมีขนาดเล็กเพื่อใหงายตอ

การนําไปประยุกตใชงาน และสะดวกตอการพัฒนาโปรแกรม โดยลักษณะของบอรดจะเนนความคุมคา 

และมีความออนตัว ทั้งดานของการศึกษาทดลอง และ การนําไปประยุกตใชงานจริงๆ โดยในดานของ

การศึกษาทดลองนั้น สามารถเลือกซื้อบอรดทดลอง Input / Output ขนาดเล็กของ ET-MINI I/O แบบตางๆ

ที่ทาง อีทีที ออกแบบและผลิตขึ้นมาสนับสนุนเพื่อเปนทางเลือกใหผูใชไดเลือกชุดอุปกรณที่ตนเองสนใจ

ศึกษาทดลอง เพื่อนํามาติดต้ังใชงานรวมกับบอรดของ ET-BASE AVR EASY88 ไดอยางงายดาย สําหรับ

กรณีที่จะนําบอรดไปเขียนโปรแกรมเพื่อสรางเปนชิ้นงานจริงๆนั้น ก็สามารถนําไปดัดแปลง หรือ เชื่อมตอกับ

อุปกรณตางๆไดโดยงายตามความเหมาะสม ซึ่งเรียกไดวา บอรดเดียวใชไดทั้งเรียนรูและใชงาน 
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คุณสมบัติของบอรด 

 
• เลือกใช MCU ตระกูล AVR เบอร ATMEGA88 ของ ATMEL เปน MCU ประจําบอรด โดยเลือกใช

แหลงกําเนิดสัญญาณนาฬิกาแบบ Crystal Oscillator คา 19.6608 MHz เพื่อใหสามารถใชงาน

พอรตสื่อสารอนุกรม RS232 ไดอยางลงตัว  

• สามารถเปลี่ยนไปติดต้ังใชงาน MCU ตระกูล AVR ขนาด 28 PIN เบอรอ่ืนๆในอนุกรมเดียวกันได 

เชน ATMEGA8,ATMEGA48,ATMEGA168 และ ATMEGA328 เปนตน โดย MCU เหลานี้จะมี

ตําแหนงขาที่เขากันได สามารถติดต้ังใชงานในบอรดไดทันที โดยไมตองดัดแปลงแกไขวงจร 

• มีหนวยความจํา 8 KByte Flash / 512 Byte EEPROM / 1024 Byte SRAM 

• มีพอรต I/O ขนาด 20 บิต จํานวน 3 พอรต (PB(6บิต),PC(6บิต),PD(8Bit)) 

 มีวงจรสื่อสารอนุกรม UART จํานวน 1 พอรต  

 มีวงจรสื่อสาร SPI จํานวน 1 พอรต 

 มีวงจรสื่อสาร I2C จํานวน 1 พอรต 

 มีวงจร Timer/Counter ขนาด 16 บิต 1 ชุด และ Timer/Counter ขนาด 8 บิต 2 ชุด 

 มีวงจร ADC ขนาด 10บิต จํานวน 6 ชอง 

• MCU ประจําบอรดไดรับการติดต้ัง Bootloader สําหรับใช Upload Code ใหบอรดผานทางพอรต

สื่อสารอนุกรม RS232 ไดทันที โดยไมตองใชเครื่องโปรแกรมภายนอก สามารถใชการพัฒนา

โปรแกรมไดทั้ง ภาษาแอสแซมบลี้ ภาษาซี ภาษาเบสิก และ ภาษา C++ ของ Arduino ไดทันที 

• มีขั้วตอสัญญาณ I/O แบบ TTL แบบ Header 2x5 จํานวน 3 ชุด (PB,PC และ PD) 

• มีสวิตช RESET พรอมวงจร External Reset แบบ RC Reset ภายในบอรด 

• มีสวิตช BL(PD2) สําหรับใชรีเซ็ตบอรดเขาทํางานใน Bootloader และใชทดสอบ Input 

• มีขั้วตอ RS232 สําหรับใชงาน และ Upload Code ดวย Bootloader ผาน RS232 

• มีขั้วตอ AVRISP แบบ 10PIN IDE มาตรฐาน AVRISP สําหรับใชโปรแกรม Code ใหบอรด ในกรณีที่

ไมตองการใชการ Upload Code ผานทาง RS232 ของ Bootloader 

• มีวงจรขยาย Output ดวย 74HC595 พรอมขั้วตอสัญญาณ Output แบบ IDE 10 Pin จํานวน 1 ชุด 

• มี LED แสดงสถานะแหลงจาย Power และ 2 LED สําหรับใชทดสอบการทํางานของบอรด 

• ใชกับแหลงจายไฟ 7 ถึง 10VAC/DC พรอมวงจร Bridge Rectifier และ Regulate 1A(Low Drop) 

• มีฐานสําหรับใชติดต้ังบอรดทดลอง I/O ขนาดมาตรฐาน ET-MINI I/O SET เพื่อใชงานรวมกับบอรด

ทดลองตางๆ เชน DC Motor, Stepping Motor, I2C RTC,I2C I/O,I2C EEPROM, SPI ฯลฯ 

• ขนาด PCB Size เลก็เพียง 8 x 6 Cm. 
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โครงสรางบอรด ET-BASE AVR EASY88 
 

 
 

รูปแสดง โครงสรางของบอรด ET-BASE AVR EASY88 
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• หมายเลข 1 คือ ขั้วตอแหลงจายไฟเลี้ยงวงจรของบอรด ใชกับแหลงจาย 7-10VAC/DC 

• หมายเลข 2 เปนขั้วตอสําหรับใชตอกับ ลําโพง ซึ่งถูก Drive ผานทรานซิสเตอร BC337 ดังวงจร 
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• หมายเลข 3 เปนขั้วตอสัญญาณจาก PD[0..7] ซึ่งในกรณีใชการพัฒนาโปรแกรมดวย Arduino จะ

เปนขาสัญญาณของ Digital[0..7] 

 

         
 

 

 

• หมายเลข 4 เปน LED ใชแสดงสถานะของขาสัญญาณ PB[5] หรือ Digital[13] ของ Arduino ซึ่ง 

LED นี้จะถูก Drive ผานทรานซิสเตอร BC337 ดังวงจร 
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• หมายเลข 5 เปนขั้วตอ AVRISP ใชสําหรับ Download Code ใหกับ MCU ในกรณีที่ใชการพัฒนา

โปรแกรมของบอรดเปนแบบ MCU ของ AVR ตามปรกติโดยไมผานระบบ Bootloader โดยขั้วตอ 

AVRISP นี้จะสามารถใชงานไดกับเครื่องโปรแกรมทุกรุนที่รองรับการใชงานกับ ATMEGA88 และ

ใชขั้วตอ ตรงตามมาตรฐาน AVRISP ดังรูป 
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• หมายเลข 6 เปนไอซีเบอร 74HC595 ซึ่งใชขยาย Output Port ขนาด 8 บิต โดยมีการตอวงจร

รวมกับ MCU ที่ใชในบอรด ดังวงจร 
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 โดย Output ของ 74HC595 นี้สามารถนําไปประยุกตใชงานเพื่อทําหนาที่เปน Output ทั่วๆไป หรือ 

ใชสําหรับเชื่อมตอกับ Character LCD ในแบบ 4 Bit Mode ก็ไดเชนเดียวกัน 

 

 

• หมายเลข 7 เปนขั้วตอสัญญาณ Output จาก 74HC595 ซึ่งมีขนาด 8บิต ก็คือ Q[0..7] โดยมีการ

จัดเรียงขาสัญญาณดังนี้ 
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• หมายเลข 8 เปนขั้วตอสัญญาณจาก PB[0..5] ซึ่งในกรณีใชการพัฒนาโปรแกรมดวย Arduino จะ

เปนขาสัญญาณของ Digital[8..13] 
 

        
 

 

• หมายเลข 9 เปน LED ใชแสดงสถานะของขาสัญญาณ PB[1] หรือ Digital[9] ของ Arduino ซึ่ง 

LED นี้จะถูกตอวงจรแบบ Source Current จากขาสัญญาณของ MCU โดยมี Jumper เปนตัวตัด

ตอสัญญาณระหวาง PB[1] กับ LED ซึ่ง LED นี้สามารถแสดงผลได 2 แบบ คือ ใชทดสอบการ

แสดงผลแบบ ON/OFF เมื่อกําหนดขาสัญญาณ PB[1] เปนแบบ Digital Output และ ใชทดสอบ

การแสดงผลแบบ Dimmer เมื่อกําหนดขาสัญญาณ PB[1] เปนแบบ Output PWM ดังวงจร 
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• หมายเลข 10 เปน Jumper สําหรับใชในการตัดตอสัญญาณ PB[1] กับ LED โดยเมื่อเลือกไวดาน 

ON จะเปนการตอสัญญาณ PB[1] เขากับ LED แตเมื่อเลือก OFF จะเปนการตัดการเชื่อมตอของ 

PB[1] ออกจากวงจรแสดงผลของ LED  
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• หมายเลข 11 เปนขั้วตอสัญญาณจาก PC[0..5] ซึ่งในกรณีใชการพัฒนาโปรแกรมดวย Arduino 

จะเปนขาสัญญาณของ Analog[0..5] 
 

        
 

• หมายเลข 12 เปน LED Power ใชแสดงสถานะของแหลงจายไฟ +5VDC 

• หมายเลข 13 คือ ขั้วตอ RS232 สําหรับใชงานทั่วไป และ Upload Code ใหกับ MCU ผานระบบ 

Bootloader โดยมีการจัดเรียงสัญญาณดังนี้ 
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รูปแสดง วงจรการตอสายของ RS232 สําหรับใชงานกับบอรด 
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• หมายเลข 14 คือ สวิตช RESET ใชสําหรับรีเซ็ตการทํางานของ MCU  

• หมายเลข 15 คือ สวิตช BL(Bootloader) โดยตอผานขาสัญญาณ PD[2] ใชสําหรับสราง

สัญญาณโลจิก LOW ใหกับขาสัญญาณ PD[2] เพื่อทดสอบการรับคา Input รวมทั้งการสราง

สัญญาณ Trigger Interrupt ของ INT0 รวมทั้งการใชสั่งให MCU เขาทํางานใน Bootloader โดย

ใชงานรวมกับสวิตช RESET โดยสวิตช BL มีการตอวงจรดังรูป 
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• หมายเลข 16 เปน MCU ประจําบอรด ซึ่งสามารถใชไดกับ AVR ขนาด 28ขา ไดหลายเบอร เชน 

ATMEGA8,ATMEGA88,ATMEGA168  และ ATMEGA328  

• หมายเลข 17 เปน Crystal Oscillator คาความถี่ 19.6608 MHz 

• หมายเลข 18 เปน Header สําหรับรองรับการเชื่อมตอสัญญาณกับบอรด ET-MINI ENC28J60 

ของ บริษัท อีทีที จํากัด สําหรับใชพัฒนาโปรแกรมใชงานกับระบบ Ethernet LAN 

• หมายเลข 19 เปน Jumper สําหรบัใชตัดตอขาสัญญาณของ PD2(INT0) ที่เชื่อมตอระหวาง 

PD2(INT0) ของบอรด ET-BASE AVR EASY88  กับ INT ของบอรด ET-MINI ENC28J60 ซึ่งถา

เลือกไวดาน ENA หมายถึง Enable ซึ่งจะเปนการเชื่อมตอขา INT จาก ENC28J60 เขากับขา PD2 

หรือ INT0 ของ ATMEGA88 แตเมื่อเลือกไวทางดาน DIS จะหมายถึง Disable ซึ่งเปนการตัดการ

เชื่อมตอขา INT ของ ENC28J60 ออกจากขา PD2(INT0) ของ ATMEGA88 ซึ่งตามปรกติควร

เลือกไวที่ดาน DIS เสมอ 

• หมายเลข 20 เปนตําแหนงฐานรองสําหรับยึดบอรดทดลองขนาดเล็กของ บริษัท อีทีที จํากัด ที่มี

ขนาดมาตรฐาน ในขนาด MINI I/O Size ซึ่งผูใชสามารถนําบอรดชุด ET-MINI I/O ตางๆมาตอ

ทดลองรวมกับบอรด ET-BASE AVR EASY88 ไดทันที 
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การตอใชงาน LCD รวมกับ 10PIN 74HC595 
  
 เนื่องจาก MCU เบอร ATMEGA88 มีขาสัญญาณอยางจํากัด เมื่อตองการนํามาตอใชงานกับ LCD 

จะทําใหตองสูญเสียขาสัญญาณไปหลายเสน ซึ่งอาจสงผลใหจํานวนสัญญาณไมเพียงพอที่จะนําไปทําการ

เชื่อมตอกับอุปกรณอ่ืนๆ การขยาย Output ดวย 74HC595 จะชวยลดการสูญเสียขาสัญญาณใชงานไปได

เปนอยางมาก เนื่องจากเสียขาสัญญาณในการควบคุม 74HC595 เพียง 3 เสน แตไดจํานวน Output 

เพิ่มขึ้นมาถึง 8 เสน โดยสัญญาณ Output ที่ไดจาก 74HC595 นี้สามารถนําไปใชงานเปน Output Port 

สําหรับควบคุมการทํางานของอุปกรณตางๆไดตามตองการ รวมทั้งการควบคุมการแสดงผลของ LCD ดวย 

ซึ่งในกรณีที่จะนํา Output จาก 74HC595 ไปใชควบคุมการแสดงผลของ LCD นั้น เพื่อความสะดวกในการ

ใชงาน ขอแนะนําใหจัดหาชุด ET-10PIN CLCD (ET-CONV 10 TO LCD) มาเปนตัวกลางในการเชื่อมตอ

ระหวาง ขั้ว IDE 10PIN ของ Output จาก 74HC595 หรือ 10PIN(74HC595) ดังตัวอยาง 
 

+5V

VO
RS
RW
EN

D4
D5
D6
D7

VCC
GND

D0
D1
D2
D3

A(+)
K(-)

+5V

10

1K

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16

1 2
3 4
5 6
7 8
9 10

ET-10PIN LCD
VCC

Backlight LCD_RS
LCD_RW LCD_EN
LCD_D4 LCD_D5
LCD_D6 LCD_D7

1 2
3 4
5 6
7 8
9 10

ET-10PIN LCD

BL
RW
D4
D6

RS
EN
D5
D7

VCC
BC337

10K

 
รูปแสดง วงจรของชุด ET-10PIN CLCD (ET-CONV 10 TO LCD) 
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โดยเมื่อนํา LCD มาติดต้ังเขากับชุด ET-10PIN CLCD เรียบรอยแลวจะทําใหสามารถเชื่อมตอ

สายสัญญาณระหวางขั้ว ET-10PIN CLCD กับ 10PIN(74HC595) ไดโดยงาย โดยใชการเชื่อมตอผานทาง

สายแพรขนาด 10PIN ไดทันทีดังตัวอยาง 
 

 

 

 

 

 

 

↔ 

 
 

 

 

 

 

 

 

 

→ 
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การติดต้ังบอรด ET-BASE AVR EASY88 ใชงานกบั ET-MINI I/O 

 
 ในการติดต้ังชุดทดลอง ET-MINI I/O SET เขากับบอรด ET-BASE AVR EASY88 นั้นสามารถวาง

บอรดของ ET-MINI I/O ซอนทับลงบนบอรด ET-BASE AVR EASY88 ไดทันที โดยเฉพาะอยางยิ่งถาเปน

บอรดรุน ET-MINI ENC28J60 จะมีการออกแบบขั้วสัญญาณไวรองรับโดยเฉพาะเลย สามารถทําการติดต้ัง

บอรดใชงานรวมกันโดยไมตองตอสายสัญญาณใดๆ แตถาเปนบอรด ET-MINI I/O รุนอ่ืนๆ ตองทําการตอ

สายสัญญาณระหวางบอรด ET-MINI I/O เขากับ ET-BASE AVR EASY88 ดวย ดังตัวอยาง 
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รูปแสดง ตัวอยางการติดตั้ง ET-MINI SMCC-547 กับ ET-BASE AVR EASY88 
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การติด ET-BASE AVR EASY88 ใชงานกับ ET-MINI ENC28J60 
 

 
 

รูปแสดง การติดตั้งบอรด ET-MINI ENC28J60 กับบอรด ET-BASE AVR EASY88 
 

 

 โดยบอรด ET-MINI ENC28J60 เมื่อทําการติดต้ังใชงานรวมกับบอรด ET-BASE VAR EASY88 

แลว สัญญาณการเชื่อมตอจะถูกกําหนดไวคงที่ตามการจัดสรร I/O ที่ทางอีทีที ไดออกแบบรองรับไวแลว ไม

สามารถเปลี่ยนแปลงได โดยการเชื่อมตอจะถูกกําหนดดังวงจร 

PD2
RESET#

NC
NC
NC
NC

MOSI
SCK

MISO
SS#
NC
NC
NC

NC

1
2
3
4
5
6
7
8

1
2
3
4
5
6
7
8

VCC

E
T-M

IN
I E

N
C

28
J6

0

SDO
SCK
SDI
CS#
B
NC
NC

INT#
RST#
CLKO
WOL#
A
NC
NC
GND

VCCENA/DIS

PB3(Digital-11)
PB5(Digital-13)
PB4(Digital-12)
PB2(Digital-10)

Digital-2

 
 
 

หมายเหตุ ตองกําหนด Jumper JP1 สําหรับเลือกขนาดแรงดันของแหลงจายไฟ (5V / 3V3) 
ที่อยูบนบอรด ET-MINI ENC28J60 ไวทางดาน 5V ดวย 
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รูปแสดง การติดตั้งบอรด ET-BASE AVR EASY88 กับ ET-MINI ENC28J60 
 
 

 บอรด ET-MINI 

ENC28J60 

ทิศทาง 

สัญญาณ 

บอรด ET-BASE AVR EASY88 

(SPI Bus ) 

 

 CS ← PB2(GPIO Out) เปน Output ออกจาก MCU   

 SDO ← PB3(SPI:MOSI) Output ออกจาก MCU  

 SCK ← PB5(SPI:SCK) Output ออกจาก MCU  

 SDI → PB4(SPI:MISO) Input เขาไปยัง MCU  

 INT → PD2(INT0) Input เขาไปยัง Interrupt ของ MCU  

 RST ← Output ออกจาก MCU  

 WOL → -  

 CLKO → -  

 LEDA → -  

 LEDB → -  

 

ตารางแสดง สัญญาณที่ตองใชเช่ือมตอกับบอรด ET-MINI ENC28J60 
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การพัฒนาโปรแกรมของ ET-BASE AVR EASY88 ดวย Arduino 
 

 ตามปรกติแลวบอรด ET-BASE AVR EASY88 จะทําการ ติดต้ังโปรแกรม Bootloader ไวให

เรียบรอยแลว โดยใช Bootloader ชื่อ “BOOT_EASY88_MANUAL_19_6608MHZ.HEX” ซึ่งเปน 

Bootloader ที่ทางทีมงาน อีทีที ไดนําตนฉบับจาก Arduino มาปรับปรุงเงื่อนไขการทํางานใหม เพื่อใหการ

ทํางานสอดคลองกับระบบฮารดแวรของบอรด ET-BASE AVR EASY88 ไดดียิ่งข้ึน โดยโปรแกรม 

Bootloader นี้จะใชสําหรับติดตอส่ือสารเพื่อส่ัง Upload Code จากคอมพิวเตอร PC ใหกับ MCU ในบอรด

ทํางาน โดยไมตองใชเคร่ืองโปรแกรมภายนอกใหยุงยาก ซึ่ง คุณสมบัติของ Bootloader ที่ทาง อีทีที 

ปรับปรุงเพิ่มเติมข้ึน มีคุณสมบัติการทํางานเปนดังนี้ 
 

- ส่ือสารกับโปรแกรมภายนอกดวย Protocol แบบ STK500 (STK500V1) 

- ใชความเร็ว Baudrate 19200 โดยใชความถี่ XTAL 19.6608 MHz 

- โปรแกรม Bootloader มีขนาด 2KByte ทํางานที่ตําแหนง 0x1800-0x1FFF 

- ใช LED ที่ตอกับขา Digital-13(PB5) เปนตัวแสดงสถานะในขณะที่ Bootloader ทํางาน  

- โปรแกรมใน Bootloader จะทํางานโดยอัตโนมัติทุกคร้ังหลังการรีเซ็ต โดย MCU จะเร่ิมตนทํางาน

ใน Bootloader นี้กอนเสมอ จากนั้นจะตรวจสอบสถานะทางโลจิกของขา PD2 โดยถาพบวาขา 

PD2 เปน HIGH ก็จะออกจากการทํางานใน Bootloader เพื่อไปเร่ิมตนทํางานตามคําส่ังที่เปนของ

ผูใชโดยอัตโนมัติ แตถาพบวาขา PD2 เปน LOW จะเขาทํางานใน Bootloader Programming 

Mode โดยในขณะที่ Bootloader Programming Mode ทํางาน ตอนเร่ิมตนจะเห็น LED ที่ตอไว

กับขาสัญญาณ Digital-13(PB5) กระพริบ 3 คร้ัง แลวติดคาง เพื่อรอการติดตอส่ือสารจาก

โปรแกรมสําหรับส่ังใหทําการ Upload Code ใหกับ MCU จนกวาจะถูกส่ังรีเซ็ต 
 

สําหรับบอรด ET-BASE AVR EASY88 นั้น จะใชสวิตช BL(PD2) และสวิตช RESET เปนตัวเลือกการ

ทํางานของ Bootloader ซึ่งถาตองการให MCU ทํางานจาก Code ที่ผูใชเขียนข้ึนก็ใหใชการกดสวิตช 

RESET เพียงอยางเดียว แตถาตองการให MCU เขาสูการทํางานใน Bootloader Programming Mode ก็

ใหกดสวิตช BL(PD2) คางไวแลวกดสวิตช RESET โดยตองกดสวิตช BL(PD2) คางไวกอนจนกวาจะปลอย

สวิตช RESET แลวจึงคอยปลอยสวิตช BL(PD2) เปนลําดับสุดทาย  โดยจะสังเกตเห็น LED ที่ตอไวที่ขา 

PB5 กระพริบ 3 คร้ังแลวติดคางรอไว เพื่อบอกใหทราบวา MCU เขาทํางานใน Bootloader แลว 

 แตอยางไรก็ตามในการทีจ่ะสามารถทําการติดต้ังโปรแกรม Bootloader Code ใหกบั MCU ไดนั้น 

ผูใชจําเปนตองมีเคร่ืองมือสําหรับทําหนาที่ Program Code ใหกับ MCU อยูดวย โดยใชเคร่ืองโปรแกรมที่มี

ข้ัวตอตามมาตรฐานของ “AVRISP” ของ ATMEL แบบ IDE 10 PIN ไดทันที โดยวิธีการใหศึกษาเพิม่เติม

จากหัวขอ “การโปรแกรม Bootloader ใหกับบอรด ET-BASE AVR EASY88” ในตอนทายของคูมือนี ้
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การติดตั้งโปรแกรม Arduino 
 

สําหรับโปรแกรม Arduino นั้น ไดรับการพัฒนาข้ึนมาใหสามารถใชงานกับระบบปฏิบัติการแบบ

ตางๆ ไดหลาย Platform ซึ่งปจจุบัน (เดือน ธนัวาคม พศ.2551) โปรแกรมของ Arduino ไดรับการปรับปรุง 

เปนรุน เวอรชัน่ “Arduino-0012” แลว โดยมีโปรแกรมใหเลือกใชงาน 4 Platform ทัง้ Windows,Mac OSx 

และ Linux โดยผูอานสามารถเขาไป ตรวจสอบ หรือ Download โปรแกรมรุนใหมๆของ Arduino มาใชงาน

ไดฟรีโดยไมเสียคาใชจายใดๆจาก “http://arduino.cc/” หรือ “http://arduino.cc/en/Main/Software” ซึง่ 

เปนเวปไซตที่ไดรวบรวมรายละเอียดและขาวคราวความเคล่ือนไหวตางๆ เกีย่วกับ Arduino มากมาย ซึง่

ขอมูลตางๆจะไดรับการปรับปรุงอยางตอเนื่องเปนประจํา 

สําหรับกรณี ที่ผูอานใชงานกับบอรด Arduino ของ บริษัท อีทีที นัน้ โปรแกรมตางๆจะถูกรวบรวมไวใน

แผน CD ROM เปนที่เรียบรอยแลว โดยโปรแกรมดังกลาวจะเปน รุนที่ไดรับการปรับแตงรายละเอียดให

สามารถใชงานรวมกนักับบอรดรุนตางๆทีท่างบริษัท อีทีที ผลิตข้ึนมาใหมไดดวย นอกจากนี้แลวทางบริษทั 

อีทีท ียงัไดทําการเพิม่เติม Library สวนทีท่าง อีทีท ีพัฒนาปรับปรุงข้ึนมาใหมรวมไวในชุดโปรแกรมดังกลาว

ดวยแลว พรอมกับทาํการเพิม่ Install Shield เขาไปดวยเพื่อใหผูใชสามารถทําการติดต้ังใชงานโปรแกรมได

โดยงายเชนเดียวกนักับการ Install โปรแกรมทั่วๆไป  

สําหรับข้ันตอนการติดต้ังโปรแกรมนั้น สามารถทาํไดตามข้ันตอนของ Wizard ในการติดต้ังของ

โปรแกรมไดทันท ีโดยมีลําดับข้ันตอนดังนี ้

 

1. ส่ัง Run ไฟล “ET-ARDUINO-0012-WIN.EXE” ซึ่งจะไดผลดังรูป 
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2. ในข้ันตอนนี้โปรแกรมจะใหกําหนด ตําแหนงโฟลเดอรทีจ่ะใชสําหรับติดต้ังโปรแกรม ซึ่งใหเลือก

กําหนดตามคา Default ของโปรแกรมการติดต้ัง คือ C:\Arduino-0012 แลวเลือก Next ดังรูป 
 

 
 

3. ในข้ันตอนนี้โปรแกรมจะใหกําหนด ชื่อโฟลเดอรที่จะใชสําหรับเรียกใชโปรแกรมผานทางเมนูคําส่ัง

ของ Windows ซึ่งในข้ันตอนนี้แนะนาํใหเลือกกําหนดตามคา Default ของโปรแกรมการติดต้ัง คือ 

C:\Arduino-0012 แลวเลือก Next ดังรูป 
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4. ในข้ันตอนนี้ใหเลือก Create a desktop icon ดวย เพื่อใหโปรแกรมสราง Icon สําหรับเรียกใชงาน

โปรแกรมที่หนา Desktop ใหดวย แลวเลือก Next ดังรูป 
 

 
 

5. เมื่อถึงข้ันตอนนี้ โปรแกรมกพ็รอมทาํการติดต้ังแลว โดยโปรแกรมจะแสดงคาตัวเลือกตางๆ ที่ถกู

กําหนดไวในข้ันตอนกอนหนานี้ใหทราบ เมื่อทุกอยางถกูตองใหเลือก Install ซึ่งโปรแกรมก็จะ

เร่ิมทําการติดต้ังทนัท ี
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6.  ใหรอจนกระทั้งข้ันตอนการติดต้ังเรียบรอยแลวเลือก Finish ดังรูป 
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ทดสอบเขียนโปรแกรมใชงานดวย  Arduino  
 
 หลังจากที่เราไดทําการติดต้ังโปรแกรม Arduino เปนที่เรียบรอยแลว ก็เปนอันเสร็จส้ินข้ันตอนของ

การเตรียมการแลว ลําดับข้ันตอนตอจากนี้เปนตนไป ก็เปนเร่ืองของการใชงาน การเขียนโปรแกรม และ

การศึกษาเรียนรูตางๆตามความตองการแลว แตกอนอ่ืนเราจะตองทําการติดต้ังโปรแกรมของ Arduino เพื่อ

ใชเปนโปรแกรมสําหรับศึกษาเรียนรู ซึ่งมีลําดับข้ันตอนดังตอไปนี้ 

 

1. ทําการส่ัง Run โปแกรม “arduino.exe” จะไดผลดังรูป 
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2. ในคร้ังแรกของการเรียกใชงานโปรแกรม ใหทําการกําหนดระบบฮารดแวรที่จะใชงานกับโปรแกรม

ของ Arduino ใหเรียบรอยเสียกอน เนื่องจากในปจจุบันนี้ มีการออกแบบวงจรและสรางฮารดแวร

บอรดแบบตางๆสําหรับนํามาใชงานรวมกับโปรแกรมพัฒนาของ Arduino ไวมากมายหลายรุน โดย

ในกรณีของบอรด ET-BASE AVR EASY88 ใหทําการเลือกกําหนดช่ือบอรดเปน “EASY88 BASE” 

โดยคลิกเมาสที่ “Tools → Board → “ET-EASY88 BASE”  ดังรูป 
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3. เลือกกําหนดหมายเลขพอรต สําหรับติดตอส่ือสารกับบอรด ใหตรงกับหมายเลข Comport ที่ตอใช

งานไวจริงในเคร่ืองคอมพิวเตอร PC เชน ถาหมายเลข Comport ของเคร่ืองคอมพิวเตอร PC เปน 

COM5 ใหคลิกเมาสที่ Tools → Serial Port → COM5  ดังรูป 
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4. ทดสอบเขียนโปรแกรม โดยคลิกเมาสที่ File → New แลวพิมพโปรแกรมทดสอบ หรืออาจใชการ

ส่ังเปดไฟลตัวอยางที่สรางไวแลวข้ึนมาแทนก็ได โดยในที่นี้ขอแนะนําใหทดสอบดวยโปรแกรมไฟ

กระพริบ โดยใหเลือก “File → sketchbook → Examples → Digital → Blink” ซึ่งจะไดดังรูป 
 

 
 

 

int ledPin = 13;              
 

void setup()                
{ 
  pinMode(ledPin, OUTPUT);   
} 
 

void loop()                  
{ 
  digitalWrite(ledPin, HIGH);   
  delay(1000);                   
  digitalWrite(ledPin, LOW);   
  delay(1000);                   
} 
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5. ส่ังแปลโปรแกรมโดยคลิกเมาสที่  “Sketch →  Verify/Compile” ดังตัวอยาง 
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6. ส่ัง Download Code ใหกับบอรด โดยคลิกเมาสเลือกที่ “File → Upload to I/O Board” แลวรอ

สักครูจนโปรแกรมทํางานเสร็จ ซึ่งควรไดผลดังรูป 

 

 
 

7. หลังจากที่ทําการ Upload Code ใหกับบอรดเปนที่เรียบรอยแลว บอรดก็จะเร่ิมตนทํางานตาม

คําส่ังที่เขียนไวในโปรแกรมทันที โดยจะสังเกตเห็น LED กระพริบ ติด และ ดับ สลับกันไปมา ดวย

ความเร็วประมาณ 1 วินาที ตลอดเวลา 
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การโปรแกรม Bootloader ใหกับบอรด ET-BASE AVR EASY88 
 ตามปรกติแลวบอรด ET-BASE AVR EASY88 ไดทําการโปรแกรม Bootloader ไวใหเปนที่

เรียบรอยแลว ผูใชสามารถใชงานไดทันที่ แตอยางไรก็ตามในกรณีที่ตองการเปล่ียนแปลง Bootloader หรือ 

เกิดความผิดพลาดในการใชงาน จนทําให Bootloader เสียหายไป ผูใชก็ยังสามารถทําการ โปรแกรม 

Bootloader ใหกับบอรดไดใหม โดยบอรด ET-BASE AVR EASY88 ไดออกแบบ ใหมีข้ัวตอ AVRISP 

สําหรับใชเปนชองทางในการโปรแกรม Code ใหกับ MCU ไดโดยตรง ดวยเคร่ืองโปรแกรมทุกรุนที่มีข้ัวตอ 

ตรงตามมาตรฐาน AVRISP ของ ATMEL ไดทันที โดยในท่ีนี้จะขอแสดงตัวอยาง วิธีการ โปรแกรม 

Bootloader โดยใชเคร่ืองโปรแกรม ของ อีทีที รุน “ET-AVR ISP USB V1.0” โดยใชโปรแกรม “AVR 

Studio 4” ของ ATMEL เปนตัวจัดการ ซึ่งมีลําดับข้ันตอนดังตอไปนี้ 
 

1. ตอสาย RS232 จากคอมพิวเตอร ใหกับบอรด ET-BASE AVR EASY88 และจายไฟใหบอรด 

2. ตอสาย USB ใหกับเคร่ืองโปรแกรม ET-AVR ISP USB V1 พรอมทั้งตอสายแพร 10 Pin ระหวาง

ข้ัวตอของ AVRISP ของทั้ง 2 บอรดเขาดวยกัน 

3. ส่ัง Run โปรแกรม AVR Studio 4 ดังรูป 
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4. เลือกคลิกเมาสที่ Tools → Program AVR → Connect.. →  STK500 or AVRISP จากนั้นก็ให

เลือกหมายเลขของ Comport ที่เปนของเคร่ืองโปรแกรม ET-AVR ISP USB V1 ตามที่ลง Driver ไว

พรอมกับเลือก Connect (จากตัวอยางเปน Com9) ดังรูป 

 

 
 

↓ 
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5. หลังจากที่ทําการ Connect เรียบรอยแลวใหทดสอบการเช่ือมตอโดยเลือกที่ tab ของ Main พรอม

กับเลือกเบอรของ MCU เปน ATmega88 และเลือก Programming Mode and target Settings 

เปน ISP mode แลวทดสอบเลือก Read Signature ดู ซึ่งถาทุกอยางถูกตองควรไดผลดังรูป 

 

 
 

6. ใหเลือกไปที่ tab ของ Program พรอมทั้งเลือก ตัวเลือกตางๆดังนี้ 

• Device ใหเลือก Erase device before flash programming และ Verify device after 

programming 

• Flash ใหเลือก Input HEX File เปน BOOT_EASY88_MANUAL_19_6608MHZ.HEX 

จากนั้นใหเลือกที่ Program เพื่อส่ัง Program Bootloader ใหกับ MCU ซึ่งจะไดผลดังรูป 
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7. หลังจากที่ทําการโปรแกรม Code ใหกับ MCU เรียบรอยแลว ใหเลือกมาท่ี Tab ของ Fuses เพื่อทํา

การสั่งโปรแกรม Fuse Bit ใหกับ MCU โดยใหเลือกกําหนดคาตัวเลือกดังนี้ 
 

• BOOTSZ ใหเลือกเปน Boot Flash size = 1024 word start address = $0C00 

• BOOTRST ใหเลือก Enable 

• SPIEN ใหเลือก Enable 

• SUT_CKSEL ใหเลือกเปน Ext.Crystal Osc 8.0MHz;Start-up time PWRDN/RESET : 

16K CK/14 ซึ่งเปนตัวเลือกดานลางสุด  
 

เมื่อเลือกตัวเลือกตางๆครบแลวจึงส่ัง Program ซึ่งควรไดผลดังรูป 
 

 
 

8. หลังจากทําการส่ัง program  Fuse Bit เรียบรอยแลว ใหเลือก Tab มาที่ LockBits แลวเลือกการ

Protect เฉพาะ Bootloader โดยเลือก BLB1 เปน LPM and SPM prohibited in Boot Section ซึง่

จะไดคา Lock Bit เปน 0xCF แลวส่ัง program เปนอันเสร็จส้ินกระบวนการ Program Bootloader 
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การพัฒนาโปรแกรมของ ET-BASE AVR EASY88 แบบ AVR Microcontroller 
 

 ในกรณีที่ผูใชตองการที่จะพัฒนาโปรแกรมใหกับบอรด ET-BASE AVR EASY88 แบบปรกติ ใน

รูปแบบของไมโครคอนโทรลเลอร AVR ก็สามารถทําได โดยสามารถเลือกภาษาในการเขียนโปรแกรม ไดเอง 

ซึ่งในกรณีนี้ผูใชสามารถเลือกใชภาษาใดๆก็ไดที่รองรับการใชงานกับ MCU ตระกูล AVR เบอร ATmega88 

โดย ผูใชงานสามารถบริหารจัดการระบบทรัพยากรตางๆที่อยูภายในตัว ATmega88 ไดเองท้ังหมด โดย

สามารถทําได 2 แนวทางคือ 

 

• การพัฒนาโปรแกรมโดยใชเครื่องโปรแกรมภายนอก ในกรณีนี้จะมีขอดีคือ ไมสูญเสีย

ทรัพยากรใดๆเลย ผูใชสามารถใชงานและกําหนดคุณสมบัติการทํางานของทรัพยากรตางๆที่มีอยู

ใน MCU ไดเอง ตามตองการ แตมีขอเสียคือ ตองมีเคร่ืองโปรแกรมภายนอก สําหรับทําหนาที่ 

โปรแกรม Code ใหกับ MCU โดยสามารถใชไดกับเครื่องโปรแกรมทุกรุนที่ รองรับการใชงานกับ 

MCU เบอร ATmega88 และมีข้ัวตอตามมาตรฐาน AVRISP ของ ATMEL 

 

• การพัฒนาโปรแกรมโดยใชงานรวมกับ Bootloader ในกรณีนี้จะมีขอดี คือ เมื่อทําการเขียน

โปรแกรมเสร็จแลวสามารถส่ัง Program Code ใหกับ MCU ผานทางโปรแกรม Bootloader ที่

ติดต้ังไวแลวไดทันที โดยไมตองใชเคร่ืองโปรแกรมภายนอก แตมีขอจํากัด คือ ตองเสียพื้นที่

หนวยความจํา Flash สําหรับเก็บ Code โปรแกรมไป 2KByte (0x1800 -0x1FFF) เพื่อใชติดต้ัง

โปรแกรม Bootloader ซึ่งตามปรกติแลวบอรด ET-BASE AVR EASY88 จะทําการ ติดต้ังโปรแกรม 

Bootloader ไปใหเรียบรอยแลว โดยในกรณีนี้ผูใชจะสามารถเขียนโปรแกรมใชงานไดทั้งหมด

จํานวน 6 Kbyte จากที่มีอยูทั้งหมด 8Kbyte โดยตองเขียนโปรแกรมใหมีตําแหนงการทํางานของ 

Code อยูระหวางตําแหนงแอดเดรส 0x0000 ถึง 0x17FF (0x0C00 - 0x0FFF K Word) สวน 

SRAM,EEPROM และทรัพยากรอื่นๆที่มีอยูใน MCU ผูใชยังสามารถใชงานไดครบตามจํานวนที่มี

อยูในตัว MCU ทุกประการ 
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ตัวอยางการพัฒนาโปรแกรมดวย WinAVR โดยใชงานรวมกับ Bootloader 
ตัวอยางที่จะแสดงตอไปนี้จะแสดงใหเห็นวิธีการพัฒนาโปรแกรมใหกับ ATmega88 ดวยภาษาซี 

โดยใชโปรแกรม AVR Studio4 ของ ATMEL รวมกับ Compiler ภาษาซีของ WinAVR 

1. ส่ัง Run Program AVR Studio4 
 

 
 

2. ส่ังสราง project ใหม โดยเลือกที่ project → New project จากนั้นเลือกกําหนดตัวเลือกตางๆ

ใหกับโปรแกรมดังนี้ 

• Project type เลือกกําหนดเปน AVR GCC 

• Location สําหรับบันทึก project ใหระบุตําแหนง Folder ที่ตองการใชบันทึกไฟล และ Code

ตางของ project ในตัวอยางกําหนดไวที่ “C:\test_easy88\” 

• Poject name ใหกําหนดช่ือ project ตามตองการในตัวอยางกําหนดเปน “led_blink” และให

เลือก Create initial file ไวดวย ซึ่งเมื่อเราทําการกําหนดช่ือ project name เสร็จแลว โปรแกรม

จะสรางไฟล ที่มีชื่อเดียวกันกับ project name ใหเองโดยอัตโนมัติ 
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3. เมื่อกําหนดคาตัวเลือกตางๆ ใหกับโปรแกรมเรียบรอยแลว ใหเลือกที่ Next แลวกําหนดคาใน 

Debug platform เปน AVR Simulator และเลือก Device เปน ATmega88 ดังรูป 
 

 
 

↓ 
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4. ใหพิมพคําส่ังของโปรแกรมสําหรับทดสอบการทํางาน ในหนาตาง Text Editor ของโปรแกรม โดย

ในที่นี้จะทดสอบดวย Codeโปรแกรม สําหรับทําหนาที่เปนไฟกระพริบที่ PB5 ซึ่งเปน LED ที่ติดต้ัง

ไวบนบอรด ET-BASE AVR EASY88 อยูแลว ดังตัวอยาง 

 
/******************************/ 
/* Program Test LED Blinking  */ 
/* Board : ET-BASE AVR EASY88 */ 
/* MCU   : ATmega88           */ 
/* X-TAL : 19.6608MHz         */ 
/******************************/ 
 
#include <avr/io.h> 
#define  F_CPU 19660800UL   // X-TAL = 19.6608 MHz 
#include <util/delay.h> 
 
#define PORT_LED PORTB  // Port Drive LED = PB 
#define DIR_LED  DDRB  // Port Direction  
#define LED 5                  // Pin Drive LED = PB5 
 
/********************/ 
/* Delay 1..65535 mS */ 
/********************/ 
void delay_ms(unsigned int time) 
{ 
  while(time-->0) 
  { 
    _delay_ms(1.0); 
  } 
} 
 
 
int main (void) 
{ 
  DIR_LED  |= (1<<LED);  // Pin Drive LED = Out 
   
  while(1) 
  { 
    PORT_LED &= ~(1<<LED);  // Pin LED = 0 
 delay_ms(200); 
 
    PORT_LED |=  (1<<LED); // Pin LED = 1 
 delay_ms(200); 
  } 
} 
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5. หลังจากพิมพ Code โปรแกรมเสร็จแลวใหส่ังแปลโปรแกรม โดยเลือกที่ build →rebuild all ซึ่ง

ผลจากการแปลคําส่ังจะไดเปน HEX File ที่มีชื่อเดียวกันกับ project ที่สรางไว ดังรูป 
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การส่ังโปรแกรม Hex File ใหกับบอรด ET-BASE AVR EASY88 ผาน Bootloader 
 

 ในการพัฒนาโปรแกรมของ บอรด ET-BASE AVR EASY88 ในรูปแบบของ AVR Microcontroller 

นั้น หลังจากที่ทําการเขียนโปรแกรม และส่ังแปลคําส่ังจนได HEX File เรียบรอยแลวในการส่ัง Program 

HEX Code ที่ไดจากการแปลคําส่ังของโปรแกรมนี้ ผานทางโปรแกรม Bootloader ของบอรดนั้น ขอแนะนํา

ใหใชโปรแกรม AVRDude โดยใชงานผาน AVRDudeGUI ซึ่งมีข้ันตอนดังนี้ 

1. ทําการสรางโฟลเดอรชื่อ AVRDUDE ไวใน Drive C (“C:\AVRDUDE\”) จากน้ันใหทําการ Copy 

โปรแกรมของ avrdude และ avrdudeGUI ไวใน “C:\AVRDUDE\” โดยจะมีทั้งหมด 3 ไฟลดวยกัน

คือ avrdude.exe, avrdude.conf และ avrdudegui.exe  

2. ส่ัง Run Program AVRDude.EXE แลวเลือกที่ Tab ของ Configuration ใหเลือกกําหนดคาตางๆ 

ดังตอไปนี้ 

 
 

หมายเหตุ ถาหมายเลข Comport  มากกวา com8 ใหพิมพหมายเลข Comport ลงไปในชองรับคา

ของ –P Port ไดเอง เชน com9 แตถาหมายเลข Comport มีคาเปน 2 หลักให เพิ่มเคร่ืองหมาย “\\.\” 

นําหนาช่ือหมายเลข Comport ลงไปดวย เชน ถาใชกับ Com13 ก็ใหกําหนดเปน  “\\.\com13” เปนตน 
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ใหทําการกําหนดคา Configuration ใหกับโปรแกรม AVRDudeGUI ดังนี้ 

• Location of avrdude ใหเลือกไปที่ชื่อและที่อยูของไฟล avrdude.exe ที่ไดติดต้ังไวตาม

ข้ันตอนที่ 1 ซึ่งก็คือ “C:\AVRDude\avrdude.exe” 

• -C Location of alternate configuration file ใหเลือกไปที่ชื่อและที่อยูของไฟล avrdude.conf 

ที่ไดติดต้ังไวตามข้ันตอนที่ 1 ซึ่งก็คือ “C:\AVRDude\avrdude.conf” 

• -p Device ใหเลือกเปน m88 

• -c Programmer ใหเลือกเปน stk500 

• -p Port ใหเลือกเปนหมายเลข Comport ตามที่ตอไวจริงกับคอมพิวเตอร PC 

• -b Baudrate ใหเลือกกําหนดเปน 19200 

3. เปล่ียน Tab ไปที่ File แลวเลือกกําหนดสวนของ Flash โดยใหเลือก Write และ Verify พรอมทํา

กําหนดช่ือ HEX File ไฟล ที่ตองการจะโปรแกรม ซึ่งในที่นี้จะใช HEX File ที่ไดจากตัวอยางที่เขียน

ดวยภาษาซีของ WinAVR ซึ่งจะอยูใน “C:\AVRDude\base88_led.hex” ดังรูป 

 

 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-BASE AVR EASY88 

ETT CO.,LTD -39- WWW.ETT.CO.TH 

 

4. เมื่อกําหนดคาตางๆใหกับโปรแกรมเรียบรอยแลว ใหเลือกที่ Execute ที่อยูใน Tab ของ Files  ซึ่ง

โปรแกรม avrdude จะเร่ิมตนทําการ โปรแกรม HEX File ใหกับบอรดทันที ใหรอจนเสร็จดังรูป 

 

 
 

5. หลังจากส่ังโปแกรมเสร็จใหกดสวิตช RESETบอรดจะเร่ิมตนทํางานทันที โดยจะเห็น LED กระพริบ 

ติด และ ดับ สลับกันไปมาไมรูจบ  
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